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1. Introducción: Manual de Uso para Meshmixer

Este manual fue elaborado dentro del marco del servicio social, con el objetivo de propor-

cionar una gúıa clara y de fácil acceso a cualquier persona con el deseo de aprender o reforzar sus

conocimientos dentro del programa Meshmixer.

Se pretende que el usuario tenga una curva de aprendizaje más rápida y pueda optimizar su tiempo

de trabajo; dentro de este documento se pretende otorgar una gúıa clara y accesible para el modelado

y edición de geometŕıas tridimensionales, incluyendo las funciones principales, comandos, atajos de

teclado y aplicaciones prácticas.

Ya que la impresión 3D está cada vez más al alcance de las personas, se propone a Meshmixer

como una de las herramientas más versátiles y accesibles para trabajar con las mallas y modelos 3D.

Meshmixer ofrece múltiples funciones para la manipulación de mallas y la preparación de archivos

para su impresión 3D; convirtiéndolo, aśı, en un recurso práctico tanto para principiantes como para

usuarios avanzados.

1.1. Alternativas al software Meshmixer

1.1.1. Software Gratuito

Blender:

• Tipo: Código abierto (open source).

• Usos: Modelado 3D, escultura digi-

tal, animación, simulación, renderiza-

do, composición, edición de video, y

preparación para impresión 3D.

• Ventajas: Extremadamente potente y

versátil, con una comunidad activa y

numerosos tutoriales. Compatible con

una amplia gama de formatos de ar-

chivo.

• Ideal para: Usuarios intermedios y

avanzados, artistas digitales, diseñado-

res y animadores.

• Información Adicional: Blender inclu-

ye un conjunto completo de herra-

mientas para escultura de alta reso-

lución, similar a ZBrush, pero con una

curva de aprendizaje más pronuncia-

da. Es ideal para proyectos que re-

quieren tanto modelado orgánico co-

mo técnico.
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FreeCAD

• Tipo: Código abierto, CAD paramétri-

co.

• Usos: Diseño mecánico, ingenieŕıa, ar-

quitectura y diseño de piezas para im-

presión 3D.

• Ventajas: Permite el diseño paramétri-

co (las dimensiones y formas se pue-

den ajustar basándose en parámetros),

es gratuito y compatible con formatos

estándar de la industria como STEP,

IGES y STL.

• Ideal para: Ingenieros, diseñadores

técnicos y aficionados a la impresión

3D que necesitan precisión dimensio-

nal.

• Información Adicional: FreeCAD es

excelente para crear piezas desde ce-

ro con medidas exactas, pero es me-

nos eficiente para editar o reparar ma-

llas orgánicas complejas importadas de

otros programas.

PrusaSlicer

• Tipo: Gratuito.

• Usos: Preparación de archivos para im-

presión 3D (slicing o corte en capas),

generación de soportes, y reparación

básica de mallas.

• Ventajas: Desarrollado espećıficamen-

te para impresión FDM/FFF, es in-

tuitivo, ofrece modos avanzados para

expertos y se actualiza constantemen-

te. Excelente para calibrar y obtener

la máxima calidad de impresión en im-

presoras Prusa y de otras marcas.

• Ideal para: Cualquier usuario de im-

presión 3D FDM, desde principiantes

hasta expertos.

• Información Adicional: Aunque su

fuerte no es el modelado, sus herra-

mientas de reparación de mallas (como

el .Arreglar mediante cortes 2la Reduc-

ción de artefactos”) son muy efectivas

para solucionar problemas comunes en

archivos STL.

MeshLab

• Tipo: Código abierto.

• Usos: Procesamiento, limpieza, análi-

sis y simplificación de mallas 3D, espe-

cialmente aquellas provenientes de es-

caneos 3D.

• Ventajas: Ligero, especializado en la

gestión de nubes de puntos y mallas

de alta densidad. Ofrece filtros avan-

zados para eliminar ruido, cerrar agu-

jeros, remallar y simplificar geometŕıa.

• Ideal para: Profesionales que trabajan

con escaneos 3D, arqueoloǵıa, preser-

vación del patrimonio, ingeniera inver-

sa y preparación de modelos para su

impresión.
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• Información Adicional: MeshLab es

la herramienta preferida para ”lim-

piar”modelos escaneados que suelen

venir con millones de poĺıgonos, ruido

y defectos, preparándolos para su uso

en otros softwares o para impresión.

1.1.2. Software de Pago

ZBrush

• Tipo: Software de pago (Pixolo-

gic/Maxon).

• Usos: Escultura digital de alta resolu-

ción, creación de personajes, criaturas

y assets detallados para videojuegos,

cine y VFX.

• Ventajas: Considerado el estándar de

la industria para el esculpido digital.

Ofrece un control sin precedentes so-

bre el detalle con herramientas como

DynaMesh, ZRemesher y un sistema

de pinceles avanzado.

• Ideal para: Artistas digitales profesio-

nales, estudios de videojuegos y efectos

visuales.

• Información Adicional: ZBrush utili-

za una tecnoloǵıa propia que permi-

te trabajar con decenas de millones

de poĺıgonos en tiempo real, algo que

otros softwares no pueden manejar con

la misma fluidez. Su integración con

otros softwares de pipeline como Maya

o Blender es esencial en producciones

profesionales.

Netfabb (Autodesk)

• Tipo: De pago (versión estándar y pre-

mium), con una versión gratuita bási-

ca.

• Usos: Reparación, análisis, optimiza-

ción y corte de modelos 3D para im-

presión.

• Ventajas: Herramientas de reparación

automática y manual muy robustas,

análisis de grosor de pared, generación

de soportes avanzados y capacidades

de corte para impresión en múltiples

partes. Parte del ecosistema Autodesk.

• Ideal para: Impresión 3D industrial,

ingeniera y fabricación aditiva profe-

sional.

• Información Adicional: Netfabb va

más allá de la reparación básica; per-

mite simular procesos de impresión

metalúrgica (DMLS, SLM) para detec-

tar tensiones y deformaciones antes de

imprimir, ahorrando costosos errores.

Magics (Materialise)

• Tipo: Software industrial de muy alto

costo.

• Usos: Preparación y gestión de archi-

vos para manufactura aditiva (impre-

sión 3D) profesional.
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• Ventajas: Es el software más poten-

te del mercado para la reparación y

edición de mallas STL. Ofrece control

total sobre el proceso de preparación,

soporte para formatos industriales, y

herramientas espećıficas para sectores

como el médico (planificación quirúrgi-

ca) y aeroespacial.

• Ideal para: Empresas e industrias que

utilizan la impresión 3D para produc-

cin final y prototipos funcionales de al-

ta gama.

• Información Adicional: Magics es of-

ten considerado el .estándar de oro.en la

industria. Su capacidad para manejar

archivos enormes y realizar booleanas

complejas de manera estable es incom-

parable.

Fusion 360 (Autodesk)

• Tipo: Licencia de pago (con licencia

gratuita para startups, aficionados y

educación).

• Usos: Diseño CAD paramétrico, mo-

delado orgánico (T-Splines), CAM (fa-

bricación asistida por computadora),

CAE (análisis de elementos finitos) e

impresión 3D.

• Ventajas: Combina el diseño mecánico

preciso con herramientas de modelado

libre y capacidades de fabricación en

una sola plataforma en la nube.

• Ideal para: Ingenieros, diseñadores de

productos y fabricantes que necesitan

un flujo de trabajo integrado desde el

diseño hasta la fabricación (incluyendo

impresión 3D y mecanizado CNC).

• Información Adicional: Fusion 360 es

excelente para crear modelos ”nati-

vos”perfectos para imprimir. Su espa-

cio de trabajo ”Sculpt”permite un mo-

delado orgánico, mientras que el espa-

cio ”Model”se encarga del diseño pa-

ramétrico preciso.

2. Conceptos básicos de Meshmixer

2.1. Meshmixer como software CAD

Meshmixer es un programa gratuito desarrollado originalmente por Autodesk Inc. Aunque no es

un software CAD en el sentido estricto, puede utilizarse de manera complementaria a este tipo de

programas, ya que comparte algunas funciones básicas de modelado y edición tridimensional.

La principal diferencia con un software CAD tradicional radica en que Meshmixer no emplea geo-

metŕıa paramétrica ni un historial de operaciones, sino que trabaja directamente con mallas trian-
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guladas. Esto significa que, a diferencia de programas como AutoCAD, Fusion 360 o SolidWorks,

no permite diseñar piezas con tolerancias exactas ni un control técnico milimétrico. En su lugar, se

centra en tareas como la escultura digital, reparación de modelos y preparación de archivos para

impresión 3D, lo que lo convierte en una herramienta rápida y ligera frente al diseño técnico de

ingenieŕıa.

El programa fue lanzado con el propósito de facilitar el manejo y la limpieza de modelos tridi-

mensionales, ofreciendo una interfaz intuitiva y accesible. Entre sus usos más comunes se encuentran

el ajuste de la orientación de piezas, la optimización para impresión, la reparación de geometŕıas de-

fectuosas, el análisis de grosor o estabilidad, y la creación de estructuras de soporte. También admite

múltiples formatos de entrada y salida (STL, OBJ, PLY, AMF, VRML, entre otros), lo que permite

trabajar de forma flexible en combinación con otros programas.

Según Autodesk (2025) Meshmixer permite realizar:

Mezcla de mallas mediante arrastrar y sol-

tar

Esculpido 3D y estampado de superficies

Conversión robusta a sólido para impresión

3D

Patrones y estructuras de celośıa 3D

Huecos (con orificios de escape)

Estructuras de soporte ramificadas para im-

presión 3D

Optimización automática de la orientación

de la cama de impresión, disposición y em-

paquetado

Herramientas avanzadas de selección, inclu-

yendo pincelado, lazo de superficie y restric-

ciones

Remallado y simplificación/reducción de

mallas

Suavizado de mallas y deformaciones de for-

ma libre

Relleno de huecos, puentes, cierre de bordes

y reparación automática

Cortes planos, espejado y operaciones boo-

leanas

Extrusiones, superficies desplazadas y pro-

yección sobre superficie objetivo

Tubos y canales interiores

Posicionamiento 3D preciso con pivotes

Alineación automática de superficies

Mediciones 3D

Análisis de estabilidad y grosor
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2.2. Tipos de Formatos de Archivo 3D

STL (Stereolithography): El formato más común en impresión 3D. Representa la superficie de

un objeto mediante una malla de triángulos. Solo contiene información geométrica (vértices y

caras), sin color, textura o materiales.

OBJ (Wavefront): Un formato más avanzado que puede almacenar geometŕıa, coordenadas de

textura (UV maps), normales y materiales. Muy usado en modelado 3D y animación.

PLY (Polygon File Format): Frecuentemente utilizado en escaneos 3D. Puede incluir propieda-

des como color y transparencia para cada vértice.

AMF (Additive Manufacturing File Format): Un sucesor moderno del STL. Soporta color,

materiales múltiples, gradientes de material y texturas, además de geometŕıa más eficiente.

3MF (3D Manufacturing Format): Un estándar moderno creado por un consorcio de empresas

para la impresión 3D. Intenta reemplazar al STL empaquetando toda la información del modelo

(geometŕıa, materiales, color, metadatos) en un único archivo comprimido (ZIP).

DAE (COLLADA - Digital Asset Exchange): Un formato de intercambio de assets digitales

basado en XML, usado en aplicaciones de modelado 3D interactivo. Puede ser menos eficiente

para impresión 3D.

El formato STL (Stereolithography o Standard Tessellation/Triangle Language) será el que se ma-

nejará a lo largo de este manual, debido a su facilidad de uso, amplia compatibilidad y versatilidad

con distintos programas de modelado y softwares de impresión 3D.

Aunque originalmente fue concebido para la tecnoloǵıa de estereolitograf́ıa, con el tiempo se con-

solidó como un estándar en la manufactura aditiva, convirtiéndose en el formato universal para la

preparación de modelos destinados a impresión 3D.

Este tipo de archivo permite representar modelos tridimensionales de manera sencilla mediante una

malla de triángulos que describe únicamente la superficie del objeto, sin almacenar información com-

pleja como colores, texturas, materiales o parámetros de diseño paramétrico.
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2.2.1. Naturaleza del STL

Un archivo STL define la geometŕıa de la superficie de un objeto 3D a través de una teselación

triangular:

Más triángulos → mayor resolución y detalle, pero también mayor peso del archivo.

Menos triángulos → archivo más ligero, aunque con superficies menos precisas y facetadas.

Es importante destacar que el STL no describe un sólido volumétrico en el sentido de los programas

CAD, sino que funciona como una “cáscara” tridimensional del modelo.

2.2.2. STL en la impresión 3D

Gracias a su simplicidad, el STL se ha convertido en el “lenguaje universal” de las impresoras 3D.

El software de corte (slicer) interpreta esta malla triangular para generar las instrucciones G-code,

que controlan los movimientos de la impresora capa por capa. De esta manera, el STL es un formato

esencial en la transición del diseño digital a la fabricación f́ısica, siendo el punto intermedio entre el

modelado 3D y la producción mediante impresión.

3. Herramientas del Software

3.1. Importar Modelo

Meshmixer puede importar directamente formatos como STL, OBJ, PLY, AMF y 3MF. Su formato

nativo es .MIX, que guarda toda la escena, incluyendo objetos múltiples, ediciones e historial.

No puede abrir formatos nativos de CAD (como .STEP, .IGES, .SLDPRT) o de otros softwares

de modelado (como .BLEND o .FBX). Estos archivos deben ser exportados primero a STL u OBJ

desde su software original.

Figura 1: Botón para importar o abrir archivo .mix
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3.2. Menú Edit (Editar)

Transform: Permite mover, rotar y escalar el modelo de forma manual o ingresando valores

numéricos precisos. La opción Üniform Scaling”mantiene las proporciones del objeto.

Figura 2: Rotación Figura 3: Traslación

Align (Alinear): Herramienta esencial para orientar el modelo correctamente para la impresión.

Permite alinear una parte espećıfica del modelo (origen) con un destino (ej. el plano de la

plataforma de impresión o un eje mundial).

Figura 4: Alinear
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Make Solid (Convertir en Sólido): Una de las herramientas más potentes. Convierte una malla

(que puede ser abierta o con errores) en una malla cerrada y manifiesta (watertight) lista para

imprimir. Permite ajustar la resolución y dureza del resultado.

Figura 5: Malla Figura 6: Cuerpo Sólido

Separate Shells (Separar Caparazones): Si un archivo STL contiene múltiples mallas que no

están conectadas (unidas por operaciones booleanas), esta herramienta las separa en objetos

individuales para editarlos por separado. (Solo para modelos con múltiples objetos).

Figura 7: Objetos Unidos

Figura 8: Objeto 1

Figura 9: Objeto 2
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Plane Cut (Corte con Plano): Corta el modelo usando un plano virtual. Puede descartar una

parte, mantener ambas, y tiene opciones para cerrar automáticamente el agujero resultante con

una superficie plana o curvada.

Figura 10: Ubicar plano de Corte Figura 11: Corte Hecho

3.3. Operaciones Booleanas

Combine: Agrupa varios objetos en uno solo sin fusionar su geometŕıa. Si se intersecan, seguirán

existiendo internamente como volúmenes separados. No es ideal para impresión.

Figura 12: Objetos Seleccionados Figura 13: Objetos Unidos
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Boolean Union (Unión Booleana): Fusiona dos o más objetos en un solo volumen sólido. Elimina

la geometŕıa interior donde se intersecan, creando una pieza continua.

Figura 14: Objetos Seleccionados Figura 15: Objetos Unidos

Boolean Difference (Diferencia Booleana): Sustrae el volumen de un objeto (herramienta) de

otro (objetivo). Es como esculpir o taladrar.

Figura 16: Objetos Seleccionados
Figura 17: Diferencia Hecha

Figura 18: El resultado dependerá de que elemento fue seleccionado primero y cual después.
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Boolean Intersection (Intersección Booleana): Mantiene solo el volumen donde los objetos se

superponen. Todo lo demás se descarta.

Figura 19: Objetos Seleccionados
Figura 20: Intersección Hecha

3.4. Sculpt (Esculpir)

Herramientas para deformar la superficie del modelo como si fuera arcilla digital.

1. Brushes (Pinceles):

• Inflate (inflar): Engorda zonas localizadas.

• Flatten (aplanar): Aplana la geometŕıa bajo el pincel.

• Drag/Grab/Move (arrastrar): Arrastra partes del modelo como si fuera arcilla.

• Pinch (pellizcar/afilar): Marca ĺıneas o arrugas, útil para detalles.

• Draw/Draw Sharp (dibujar/add volume): Añade volumen dibujando sobre la superficie.

• Smooth (suavizar): Sueviza la superficie.

• RobustSmooth / BubbleSmooth (Suavizado Robusto/ Suavizado Burbuja): Variaciones

de suavizado avanzado.

2. Configuración: Se puede ajustar el tamaño, fuerza y forma del pincel para un control detallado.

3.5. Analysis (Análisis)

Conjunto de herramientas para diagnosticar y preparar el modelo para impresión.
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Inspector: Detecta y corrige agujeros, bordes abiertos y errores de malla automáticamente.

Permite repararlos con un clic.

Figura 21: Errores Detectados

Units/Dimensions (Unidades/Dimensiones): Permite escalar el modelo o ajustar sus unidades

de medida (mm, pulgadas).

Figura 22: Unidades del Modelo
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Thickness (Grosor): Analiza el espesor de las paredes del modelo. Crucial para impresión en

resina (SLA/DLP) donde las paredes demasiado delgadas pueden fallar.

Figura 23: Pared Delgada Detectada

Stability (Estabilidad): Comprueba el centro de gravedad del modelo para ver si se volteará

durante la impresión. Ayuda a determinar la orientación óptima.

Figura 24: Estabilidad
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Mesh Query (Consulta de Malla): Proporciona información técnica detallada: número de vérti-

ces, caras, si la malla es cerrada, etc.

Figura 25: Información Desplegada

3.6. Select (Seleccionar)

Permite seleccionar regiones espećıficas del modelo para aplicar ediciones localizadas. Ctrl + A se-

lecciona toda la pieza.

Figura 26: Selección Personalizada Figura 27: Ctrl + A
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3.6.1. Otras Herramientas de Edición

Se puede acceder a él tras usar el comando Ctrl + A.

a) Erase & Fill (Borrar y Rellenar): Elimina la selección y cierra el hueco con una superficie

parcheada suave.

Figura 28: Objetos Seleccionados Figura 29: Borrado y Rellenado

Discard (Descartar): Elimina la selección sin rellenar, dejando un agujero abierto.

Figura 30: Objetos Seleccionados Figura 31: Descarte
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Remesh (Remallar): Reconstruye la topoloǵıa de la malla, uniformizando el tamaño de los

triángulos. Útil para simplificar modelos muy pesados o mejorar mallas desordenadas.

Figura 32: Objetos Seleccionados

Figura 33: Malla Fina

Figura 34: Malla Simplificada

Extrude (Extruir): Empuja la selección hacia afuera o hacia adentro, creando nuevo volumen.

Figura 35: Objetos Seleccionados Figura 36: Extruir
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Extract (Extraer): Crea un nuevo objeto a partir de la selección, añadiéndole un grosor definido

(como una cáscara).

Figura 37: Objetos Seleccionados

Figura 38: Extraer

Offset (Desplazar): Genera una copia de la selección agrandada o encogida de manera uniforme.

Figura 39: Objetos Seleccionados Figura 40: Desplazar

Separate (Separar): Convierte la selección en un nuevo objeto independiente.
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Figura 41: Objetos Seleccionados
Figura 42: Separar

Flip Normals (Voltear Normales): Invierte la dirección de las caras de la malla. Las caras con

normales invertidas pueden causar problemas en el software de corte.

3.6.2. Menú Deform (Deformar)

Se puede acceder a él tras usar el comando Ctrl + A.

Soft Transform (Transformación Suave): Mueve una selección deformando gradualmente la

geometŕıa circundante, manteniendo una transición suave.

Figura 43: Objetos Seleccionados Figura 44: Deformado Suave
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Smooth (Suavizar): Reduce las irregularidades y asperezas de la superficie.

Figura 45: Objetos Seleccionados Figura 46: Deformado Suave

Warp (Deformar): Dobla y tuerce el modelo de forma libre.

Transform (en Deform): Similar a la herramienta principal, pero a menudo con opciones para

mantener la conectividad.

3.6.3. Menú Convert To (Convertir a)

Se puede acceder a él tras usar el comando Ctrl + A.

Convert to Solid Part: Crea una versión sólida y limpia del objeto.

Convert to Open Part: Descompone el objeto en superficies editables por separado.

Convert to Stamp: Convierte la selección en un sello o relieve que se puede aplicar sobre otra

superficie.

3.6.4. Menú Modify (Modificar)

Se puede acceder a él tras usar el comando Ctrl + A.

Select All (Ctrl + A): Selecciona todo el modelo 3D, incluyendo todas las caras de la malla.

Select Visible: Selecciona únicamente las caras visibles desde la cámara, ignorando las que están

ocultas detrás.

Expand Ring: Expande la selección siguiendo el anillo de caras alrededor del área ya seleccio-

nada.
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Contract Ring: Reduce la selección siguiendo el mismo patrón de anillo, quitando una franja

de caras.

Expand to Connected (E): Ampĺıa la selección a toda la malla conectada topológicamente. Muy

útil si hay varias piezas separadas en un mismo archivo.

Expand to Groups (G): Expande la selección a todo el grupo de caras al que pertenecen las

seleccionadas (por ejemplo, un Face Group).

Invert (I): Invierte la selección: lo que estaba seleccionado se deselecciona y lo que no, se

selecciona.

Invert (Connected) (Shift + I): Igual que el anterior, pero solo aplica a la malla conectada.

Optimize Boundary (O): Suaviza y reorganiza los bordes de la selección para que sean más

uniformes.

Smooth Boundary (B): Suaviza la frontera entre lo seleccionado y lo no seleccionado, eliminando

irregularidades en la transición.

Create FaceGroup (Ctrl + G): Crea un grupo de caras (Face Group) a partir de la selección,

lo que facilita aislar o trabajar solo en esa parte después.

Clear FaceGroup (Ctrl + Shift + G): Elimina el Face Group de la selección, devolviendo esas

caras a un grupo general sin clasificación.
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4. Trabajar un Modelo .STL – Flujo de Trabajo Básico

4.1. Importar el Modelo

Abre el archivo STL (u otro compatible) mediante File > Import o arrastrándolo a la ventana de

Meshmixer.

Recuerda que el Software está limitado a los siguientes formatos: (STL, OBJ, PLY, AMF, 3MF,

MIX). Si exportaste tu modelo desde algún Software CAD asegúrate de que esté en alguno de estos

formatos.

Figura 47: Selecciona el Archivo STL Figura 48: Modelo Importado

4.2. Colocar y Orientar (Transform/Align)

Usa Transform para mover, rotar y escalar el modelo a su tamaño final. Utiliza Align para asegurarte

de que esté plano sobre la plataforma de impresión (ej., alinear la base más plana con el plano XY).

Figura 49: Modelo Orientado
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4.3. Verificar y Reparar Imperfecciones (Analysis > Inspector)

Ejecuta el Inspector para encontrar y reparar automáticamente agujeros, caras invertidas y bordes

colgantes. Esta es la etapa más crucial para garantizar una impresión exitosa.

Figura 50: Errores Detectados en la Malla

4.4. Suavizar la Superficie y Mejorar el Modelo (Sculpt > Smooth o

Deform > Smooth o Edit > Transform)

Si el modelo tiene un aspecto pixelado o con escalones (low-poly), usa el pincel ”Smooth”para sua-

vizar la geometŕıa de manera uniforme. Si es necesario agrega objetos extra para completar alguna

geometŕıa, une las partes , si es necesario conviértelo a sólido, a veces es más fácil trabajar un modelo

sólido.

Figura 51: Modelo Original
Figura 52: Modelo Suavisado
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Figura 53: Modelo Mejorado
Figura 54: Modelo unido

En este caso, la geometŕıa de la base estaba deformada, aśı que se decidió reemplazar por una nueva.

Figura 55: Base Reemplazada Figura 56: Modelo Cortado

4.5. Convertir a Sólido (Edit > Make Solid)

Esta herramienta es excelente para crear una malla limpia, uniforme y lista para imprimir. Ajusta la

resolución según sea necesario: un valor más alto preserva más detalles, uno más bajo simplifica el

modelo.
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Figura 57: Modelo Final

4.6. Exportar el Modelo Reparado

Una vez que el modelo está limpio y orientado, expórtalo a STL o 3MF mediante File > Export.

Este nuevo archivo estará listo para ser abierto en tu software de corte (slicer) favorito.

Figura 58: Caption
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4.6.1. Elegir Formato de Exportación

La diferencia entre exportar un modelo en formato .STL ASCII y .STL Binary, radica en cómo se

almacena la información del modelo en el archivo. Ambos formatos contienen la misma geometŕıa,

pero el modo de codificación es distinto. ASCII guarda el modelo como texto legible por humanos;

mientras que Binary guarda el modelo como datos binarios

Figura 59: Comparación de Formatos
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